
Hitchhiker’s Guide to the  
Network at All God’s Children 

A L L  I N  ( a b o u t )  O N E  C O N C I S E  P A G E !  

Overview 
Network of computers, servers, printers and software applications located within the church 
building.  

Connections 
Wired connections are located in all offices, Ackerman Hall, Narthex, mechanical room and 
balcony. 
 
Wireless secured access to all network resources is available in most offices and the sanctuary.    
SSID: AGCMCC    Security Key: <available upon request> 
 
WiFi connections are available throughout facility (Internet only - no church resources).   
SSID: AGC-Public-Guest     Security Key: <posted in gathering space> 

Computers 

NAME DESCRIPTION REMOTE ID SOFTWARE 

AGC-Server File server  QuickBooks 2004 

Andrew Worship graphics projection  SongShowPlus, Office 2003 

Bartholomew Music Director (new computer)  Office 2010 Pro, Servant Keeper 

 Music Director (old computer) 704539042  

James Staff office  Office 2010 Pro, Servant Keeper 

John Conference room  Office 2010 Pro 

Judas HVAC  Proliphix 

Matthew Podcasting 489761970 QuickBooks 2013 

Peter *FUTURE*   

Philip Reception  Office 2010 Pro, Servant Keeper 

Simon Volunteer office 497302195 Office 2010 Pro 

Thaddeus *FUTURE*   

Thomas Pastor  Office 2010 Pro, Servant Keeper 

Printers 

NAME DESCRIPTION IP ADDRESS FEATUIRES 

iR3570 Canon monochrome printer 192.168.1.210 Copy, print, scan, collate, staple, 11x17 

HP3055 HP monochrome laser printer 192.168.1.211 Fax, print, scan, copy 

CLP610 Samsung color laser printer 192.168.1.212 Print 

 
 
 



Shared Storage 

NAME DESCRIPTION DRIVE ACCESS 

SKCM50 Servant Keeper software and data K: Upon request 

SongShow SongShow Plus video projection P: Staff and Tech Team 

Library 
Digital assets (branding, logos, 
fonts, templates, forms, graphic 
elements, videos and pictures

L: Everyone read-only, Staff has full access 

Staff All things staff S: Staff 

NetAdmin Network support files  Tech Team 

Remote Access  
Team Viewer is the software that we use to bridge cloud computing and our local network of 
computers. Team Viewer lets you control church computers remotely (like RDP or Terminal 
Services), share files, make presentations, record activity and much more.  
 
Most users will find everything they need in the AGC SharePoint Portal and won't need remote 
access. To get remote access you will need to install Team Viewer on your computer or mobile 
device. You will need the Team Viewer ID of the computer you want to control (see above list of 
computers) and a special remote access password in addition to your regular church network 
login credentials.   

Help 
If you need help just let your friendly technology team know. We can be reached at 
technology@agcmcc.org. 



Hitchhiker’s Guide to 

Credentials at All God’s Children 
A L L  I N  O N E  C O N C I S E  P A G E !  

Overview 

You are able to retrieve your email in two ways. The first is web based -- similar to HotMail or 
Gmail. The second way is POP based and works with Outlook and other similar programs. You 
are free to use either or both, however be careful in using both since it can be confusing where 
your messages are stored.  
 
Regardless of how you choose to retrieve your email, you will still need to administer your email 
account through the web. Here you will be able to setup all sorts of nice things for yourself such 
as a reply address, forwarding rules, vacation rules, confirmation, formatting, and a signature. 
You can also change your password here from the default one that has been supplied to you.  
 

Email 

 
Login: 
 
Password: 

 

SharePoint 

 
Login: 
 
Password: 
 
 

Network 

 
Login: 
 
Password: 
 



Hitchhiker’s Guide to 
SharePoint at All God’s Children 

A L L  I N  O N E  C O N C I S E  P A G E !  

Overview 
SharePoint is a Web-based collaboration tool which allows information sharing and document 
collaboration. SharePoint lets you create a central location where everyone can share issues, 
contacts, announcements, Web links, and calendars. Team members can easily create 
workspaces for meeting discussions, surveys, documents, task lists, and other collaboration 
needs that increase their productivity. 

Requirements 
SharePoint is accessed through your regular web browser (Firefox, Internet Explorer, Chrome, 
mobile browser), however Internet Explorer is highly recommended for all features to work 
properly. Some plug-ins may need to be installed fir advanced features.  

Access 

Point your web browser to:  https://allgodschi79971.serverdata.net  and login when 
prompted to do so.  

Credentials 
 

Login:  
 
Password: 

Help 
If you need help just let your friendly technology team know. Our helpdesk can be reached at 
helpdesk@agcmcc.org. 
 
 



Hitchhiker’s Guide to 
Email at All God’s Children 

A L L  I N  O N E  C O N C I S E  P A G E !  

Overview 
You are able to retrieve your email in two ways. The first is web based -- similar to HotMail or 
Gmail. The second way is POP based and works with Outlook and other similar programs. You 
are free to use either or both, however be careful in using both since it can be confusing where 
your messages are stored.  
 
Regardless of how you choose to retrieve your email, you will still need to administer your email 
account through the web. Here you will be able to setup all sorts of nice things for yourself such 
as a reply address, forwarding rules, vacation rules, confirmation, formatting, and a signature. 
You can also change your password here from the default one that has been supplied to you.  
 

The difference between an email client and webmail client 

An email client is a program that is used to access email. Email clients can be located either 
locally on a computer or on the internet (clients based on the internet are known as "webmail 
clients").  

An email client typically provides more options for mail management than a webmail client, and 
also has the ability to work offline. Common email clients include Outlook, Apple Mail, and 
Thunderbird.  

A webmail client allows you to access your mail from anywhere, requiring only an internet 
browser. Common webmail clients include AtMail, SquirrelMail, Gmail, Hotmail, and Yahoo 
Mail. 

Definitions 

An email address is a label that usually identifies a mailbox where email can be sent. Email 
addresses have the format: name@domainname - for example, support@yourdomain.com. Each 
email address is unique, much like a regular postal address.  

An email alias acts as a kind of relay station. Mail that reaches the forward is routed to one or 
more destination email addresses. Forwards do not store messages as mailboxes do. 

An email mailbox is an area on a network where email is received, stored and retrieved. An 
email address identifies the mailbox. Each hosting account has a designated number of available 
mailboxes, which have a defined amount of storage/disk space.   

A mailbox stores your email messages. You access your mailbox using the mailbox name and 
password, and a client of your choice (we'll discuss clients a bit later). Once logged in, you can 
read your mail, reply, delete, organize into folders, and basically manage your email any way you 
like. 

An email forward give you the ability to create targeted email addresses like 
"sales@domain.com." On WebHost4Life, forwards can route to mailboxes, external email 



addresses or lists of email addresses. Forwards do not store messages as mailboxes do; 
therefore, they do not have storage limits. You can create an unlimited number of forwards. 

An email distribution list 

 
Webmail vs. Email Clients 

There are two basic types of mail clients: webmail and email. A webmail client (such as AtMail, 
Gmail, Yahoo!, etc.) allows you to access your email from any web browser, on any computer. An 
email client (Microsoft Outlook, iPhone) is stored on the device (for example, only your iPhone 
connects to your mailbox), allows you to access messages offline, and typically offers a wider 
range of mail management features. 

Which one should you choose? It's completely up to you! You can even have both - an email 
client for your iPhone, and a webmail client to use when traveling or away from home. 

Web Based Email and Administration Control Panel 
This is the place where you administer your email account and optionally send/receive email. The 
online help is actually pretty good if you need assistance with personalizing your email account. 
Here is how you get to your personal control panel: 
 

1.) Point your web browser to: http://webmail.agcmcc.org 

2.) Enter your user name - which is your complete email address, including @agcmcc.org 
(for example technology@agcmcc.org) 

3.) Enter your password 

4.) Click the Login button 

Email Client  
If you don’t want to retrieve email via Outlook or a similar email client then you can ignore this 
section. Here are the settings to retrieve POP email: 
 
Incoming Mail (POP3):  pop.agcmcc.org 
Outgoing Mail (SMTP):  smtp.agcmcc.org  (or use your own ISP for outbound) 

Incoming Account Name:  your complete email address (including  @agcmcc.org) 

Incoming Password:  your password 

Restrictions 

 Maximum email size of 25MB including attachments 
 No more than 500 emails per hour 
 No more than 5,000 emails a day 
 Capacity of mailbox is 50mB or 3,000 emails 
 The following file types are forbidden to be sent: .bat, .btm, .cmd, .com, .cpl, .dll, .exe, 

.lnk, .msi, .pif, .prf, .reg, .scr, .vbs, .url  

Help 
If you need help just let your friendly technology team know. Our helpdesk can be reached at 
helpdesk@agcmcc.org. 
 



Configuring an Email Client  
This article contains instructions for setting up email access using POP, IMAP, and SMTP 
connections through various email clients, including Microsoft Outlook, Apple Mail, and Mozilla 
Thunderbird. It also lists the email settings and port numbers for POP, IMAP, and SMTP 
configurations, as well as for SSL connections.  
 
Difference between POP and IMAP settings 

POP - an internet standard for retrieving email. POP stands for "Post Office Protocol." May also 
be referred to as "incoming mail." 

POP is a one-way communication path. This means that when you access your email from your 
computer or other local device, your email client (such as Outlook or Thunderbird) will save a 
local copy of the email to your computer, then delete the original from the mail server. 
Email accessed using POP ties it to a specific computer or device, thus you will be unable to view 
your webmail from multiple sources. However, POP is useful for storing local copies of email to 
be read offline or when not connected to the internet, as well as for ensuring that your webmail 
mailbox in MailCentral will retain plenty of storage room for accepting more email in the future.  

IMAP - an internet standard for retrieving email. IMAP stands for "Internet Message Access 
Protocol." May also be referred to as "incoming mail."  

IMAP is a two-way communication path. This means that when you access your email from your 
computer or other local device, any changes that are made will be synchronized with your 
webmail on the mail server. For example, if you log in to MailCentral, create a new folder in 
your webmail, then put a message into that folder, this change will instantly and automatically 
appear in your email client (such as Outlook or Thunderbird), and on your mobile device. Also, if 
you are at work and you begin a message then save it, it will still be there in your mailbox when 
you log in from a different email client, such as one on your home computer.  

IMAP provides a better method to access your mail from multiple devices, say from work, home, 
and your mobile, through two-way syncing capabilities between your mail clients and the 
WebHost4Life mailbox. However, because IMAP saves all your messages on the server, be sure 
frequently clean up your mailbox, deleting old messages and saving the ones you want to keep to 
a local computer.   

Email server names and ports 

The Email Server Names settings are:  

 Incoming Mail Server - pop.agcmcc.org 
 Outgoing Mail Server - smtp.agcmcc.org 

The email server ports are: 

 POP: 110 
 IMAP: 143 
 SMTP: 587  



Configure Outlook as your Email Client to access your POP mailbox 

The process below adds a POP mailbox as an account in your existing Outlook profile.  

1. Click Setup next to the mailbox that you want to configure with Outlook. The 
information you need to configure the new account (ports and mailservers) is displayed: 

 
2. Open Outlook 
3. Select Tools > E-mail Accounts... 

 
4. Select Add a new email account, then click Next  
5. Select POP3, then click Next  



6. Fill out the input fields as shown (all information necessary is in step 2 above): 
 

 

 Your name: the name that you wish to appear on your emails in the "From" 
field 

 Email Address: the email address of the mailbox 
 Incoming mail server (POP server): see step 2 above - for example: 

pop.example.com (where "example.com" is your hosting account's 
PrimaryDomain) 

 Outgoing mail server (SMTP server): see step 2 above - for example: 
smtp.example.com (where "example.com" is your hosting account's 
PrimaryDomain) 

 User name: your full mailbox name, for example: 
administrator@example.com 

 Password: your mailbox password 

7. Click More Settings... 
 Select the "Outgoing Server" tab 
 Select "My Outgoing Server (SMTP) requires authentication" 



 

8. Click OK  
9. Click Test Account Settings. All settings should work. 
10. Click Next, then click Finish. 



Configure Apple Mail as your email client (IMAP) 

To configure Apple Mail, you first need to verify your primary domain, then check the IMAP 
settings for an email client : 

1. Verify your primary domain 
1. Log in to your control panel, then go to DomainCentral 

 
2. Your primary domain is denoted by a globe icon. In this example, our 

primary domain is demotutorials.net 
2. Start Apple Mail. Select File > Add Account. The Add Account wizard opens - it 

guides you through this process step by step 

 
3. Fill out the following fields: 

 Full Name - enter the name of the mailbox owner, exactly how you want it 
to appear in the "From" field on your emails. For example, John Forth 



 Email Address: enter the full address of your WebHost4Life mailbox. In 
this example, it's administrator@demotutorials.net 

 Password - enter the mailbox password. If you don't remember what the 
password is, go back to MailCentral. You can reset mailbox password there. 
 
Click Continue once you've completed this step. 

 
4. For Incoming Mail Server, complete the fields as follows: 

 Account Type - select IMAP from the dropdown 
 Description - enter an email account description, which will appear in your 

Apple Mail account list. You might want to make this descriptive, like "Hosting 
Admin Mailbox" 

 Incoming Mail Server - enter imap.primarydomain, where primarydomain 
is the domain you verified in the first step. In this case the primary domain is 
demotutorials.net, so the incoming server is imap.demotutorials.net 

 User Name - enter the full address of your mailbox (a common mistake 
is to enter just Administrator, or the name, not the actual full address) 

 Password - enter the mailbox password (should be filled out already) 
 



Click Continue once you've completed this step. 

 
5. For Outgoing Mail Server, complete the required fields as follows: 

 Description - enter the same description as in the previous screen 
 Outgoing Mail Server - the outgoing mail server is smtp.primarydomain. In 

this case, the primary domain is demotutorials.net, so the setting is: 
smtp.demotutorials.net 

 Use Authentication - check the box 
 User Name - enter your full mailbox address 
 Password - enter your mailbox password 

 



Click Continue once you've completed this step. 

 



6. Check the account summary to make sure that all setting were entered correctly. If it is 
correct, click Create. You are done! 

 
7. Your new account appears in the list of Mailboxes in your Apple Mail. Notice that the 

mailbox description that you created in step 4 above is displayed as this mailbox's name. 

 



Configure Thunderbird as your Email Client to access your POP/IMAP 
mailbox (manual) 

The process below adds a POP/IMAP mailbox as an account in your existing Thunderbird profile.  

1. Log in to MailCentral.  
2. Click Setup. The information you need to configure the new account (ports and 

mailservers) is displayed 

 
3. Open Thunderbird 
4. Select Tools > Account Settings 
5. Click Account Actions, then select Add Mail Account 

 
6. Fill out the input fields as shown (all information necessary is in step 2 above): 



 Your name: the name that you wish to appear on your emails in the "From" 
field 

 Email address: the email address of the mailbox 
 Password: your mailbox password 

 
Click Continue once you've completed this step.  

 
7. Thunderbird will begin to look for your email configuration based off of the information 

you entered in step 6 above. Once found, you will have the option of choosing an IMAP 
or POP connection for incoming mail. 
 
NOTE: Please refer to the Difference Between POP and IMAP settings article to 
determine which incoming mail retrieval standard is a best fit for your current needs.  

8. To complete your account setup: 
 If you plan on using the default settings (recommended for most users), 

click Create Account and proceed to step 9. 
 To manually configure your email server settings (recommended for 

advanced users), click Manual Config. The additional information shown in the 
screen below will appear. You will now be able to manually enter the server 
hostname, port information, SSL information, and how you want Thunderbird to 
authenticate the account for the Incoming and Outgoing mail settings. Click 
Create Account to finish the manual configuration of your email in Thunderbird.  



 

 
9. You will be taken back to the "Account Settings" screen. You may choose to modify 

the details for your email account here (please refer to Thunderbird online support for 
further assistance with this). Once you have completed reviewing this information, click 
OK. 

 



10. You will be taken back to the "Local Folders" screen. You have now successfully set 
up a mailbox in Thunderbird. Your mailbox will appear in the list on the left side of this 
screen. Click "Inbox" under the name of your email address that you configured to get 
started using your mailbox.  

 

 



Set up Open-Xchange Webmail in your Account 

The first time you sign in to OX webmail you will be prompted with a wizard that will help you get 
your webmail account set up.  

NOTE: You can turn this wizard off for future logins via a checkbox in the bottom left corner 
labeled "Do not show on start". 

The wizard has four steps:  

1. Complete your account information  
 After clicking through the first screen, you will be prompted to enter your 

personal information  
 Certain items will auto-populate based on information from your hosting 

account profile  
 Mandatory fields include your first name, last name, and the name that you 

want displayed when using OX webmail.  
2. Subscribe services  

 Provides the option to subscribe to other email services, such as Gmail or 
Yahoo mail  

 Allows for IMAP or POP connections  
3. Configure your handheld device  

 Lists instructions for supported mobile devices that can be used with the 
Open-Xchange server  

 Mobile devices using ActiveSync require an upgrade to Open-Xchange 
Mobile Email  

4. Download updater  
 Provides a link to download an updater for the Connector for Microsoft 

Outlook to sync webmail with Outlook  
 Once downloaded, you must follow the on-screen instructions to complete 

the installation of the Connector for Microsoft Outlook  

Once you reach the final screen, click Close to save your settings and proceed to your Open-
Xchange homepage.  

Navigate Open-Xchange 

Once you've logged in to Open-Xchange (OX) webmail via MailCentral, you will by default be 
brought to your Inbox.Here you can compose messages and review any mail that you have 
received. Please refer to the Composing an email in Open-Xchange knowledgebase article for 
more information on this topic.  

The icons listed at the top left corner of the screen are used to access the various features of OX 
webmail. They are (from left to right):  

 Home (house icon) 
 Mail (envelope icon) 
 Calendar (icon shaped like a spiral-bound notebook showing the number 13)  
 Contacts (icon shaped like the silhouette of a person) 
 Tasks (clipboard icon)  
 Infostore (briefcase icon) 



 Configuration (gear icon) 

NOTE: Infostore is only available to users who have purchased a Business Email credit for their 
Open-Xchange webmail. If your webmail account has not been upgraded to Open-Xchange 
Business Email, this icon will appear with a gold lock on it until it has been upgraded. Please 
contact Support for more information about upgrading to Open-Xchange Business Email. 

  

Expert Mode  

Additionally, there is a checkbox for "Expert Mode." Checking this box will open a new panel on 
the left side of the screen that displays a more detailed list of actions that can be taken in Open-
Xchange.  

 

 

Customize the Open-Xchange Home page 

Clicking the house-shaped icon in the top left corner of the screen takes you to the Home page. 
An example of the default configuration for this page can be seen below:  



 

 

On this page, you are presented with a summary of any email received, upcoming appointments, 
a list of items located in the InfoStore, and any tasks that you may have set. The items that are 
displayed on this page can be customized by doing the following: 

1. When logged in to Open-Xchange, clicking the Configuration icon 
2. Click the arrow next to "Start Page" to expand this category, then click "Layout" 
3. Make any desired changes in the screen that appears on the right 
4. Click Save to confirm your changes 

  

You can also change the layout of the home screen by clicking the "Change Layout" link next to 
the displayed name for the webmail account. The layouts that you can use are shown below: 

 

 

Return to this home screen at any time by clicking the Home icon in the top left corner of the 
screen.   

  

Compose an email in Open-Xchange 
To compose a new email using Open-Xchange webmail: 

1. Log in to MailCentral  
2. Click the Webmail link next to the email address you want to use  



3. By default, you will be taken to the mail page in Open-Xchange (note that you may 
access this page any anytime while logged in to Open-Xchange by clicking the Mail icon 
shaped like an open envelope at the top left corner of the screen). 

 
4. Under the "New" or "Edit" tabs, click New E-mail to begin composing a message 

 
5. Click Send to send your message 

Create a Calendar Entry in Open-Xchange 



To create a new appointment in your Open-Xchange webmail calendar: 

1. Log in to MailCentral  
2. Click the Webmail link next to the email address you want to use  
3. Click the Calendar icon (it looks like a spiral-bound notebook with the number 13) at 

the top left corner of the screen. This takes you to the Calendar page. 

 
4. Under the "New" or "Edit" tabs, click New Appointment to begin creating a new 

calendar entry 

 

 

5. Click Save to add the appointment to your calendar 


